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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP Compaq 6910p
Notebook PC with
UMA video memory

HP Compaq 6910p
Notebook PC with
discrete video
memory

Processors Intel® Core™ Duo processors:

● T7700 2.4-GHz processor with 800-MHz Front
Side Bus (FSB) and 4-MB L2 cache

● T7500 2.2-GHz processor with 800-MHz FSB
and 4-MB L2 cache

● T7300 2.0-GHz processor with 800-MHz FSB
and 4-MB L2 cache

● T7100 1.8-GHz processor with 800-MHz FSB
and 2-MB L2 cache

√ √

Chipsets ● Northbridge: Intel PM965 with up to 800-Mhz
FSB with iAMT support

 √

 ● Northbridge: Intel GM965 with up to 800-Mhz
FSB with iAMT support

√  

 ● Southbridge: Intel ICH8-M enhanced √ √

Graphics ATI M64S PCI Express, 64-bit VRAM bus:

● 128-MB GDDR3 video memory (256-MB
Hypermemory)

● 64-MB GDDR3 video memory (256-MB
Hypermemory)

 √

 Intel Crestline Graphics Media Accellerator, Unified
Memory Architecture (UMA), integrated with shared
video memory, up to 384-MB shared memory

√  

Panels 16:10 aspect ratio display panels:

● 14.1 WXGA+ (1440 × 900), configured with 3
WLAN antennas and 2 WWAN antennas

● 14.1 WXGA (1280 × 800), configured with 3
WLAN antennas and 2 WWAN antennas

● Supports privacy filter

√ √
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Category Description HP Compaq 6910p
Notebook PC with
UMA video memory

HP Compaq 6910p
Notebook PC with
discrete video
memory

Memory ● Two SODIMM slots, both customer accessible/
upgradable (memory slot under the keyboard
must be populated first)

● DDRII PC2-5300 (667-MHz)

● Supports dual-channel memory

● Supported configurations:

◦ 4096 MB total system memory (2048 MB
× 2, dual-channel)

◦ 3072 MB total system memory (2048 MB
+ 1024 MB, dual-channel)

◦ 2560 MB total system memory (2048 MB
+ 512 MB, dual-channel)

◦ 2048 MB total system memory (2048 MB
× 1; 1024 MB × 2, dual-channel)

◦ 1536 MB total system memory (1024 MB
+ 512 MB, dual-channel)

◦ 1024 MB total system memory (1024 MB
× 1; 512 MB × 2, dual-channel)

◦ 512 MB total system memory (512 MB ×
1)

√ √

Hard drives ● Supports all 9.5-mm, 2.5-inch hard drives

● Serial ATA

● The following hard drives are available:

◦ 160-GB, 5400-rpm

◦ 120-GB, 5400-rpm

◦ 100-GB, 7200-rpm

◦ 80-GB, 7200- and 5400-rpm

√ √

Optical drives ● 9.5-mm tray load

● MultiBay II

● Supports all common optical formats, including
the following:

◦ DVD±RW and CD-RW Double-Layer
Combo Drive

◦ DVD/CD-RW Combo Drive

◦ DVD-ROM Drive

√ √

Diskette drive Supports external USB drive only √ √
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Category Description HP Compaq 6910p
Notebook PC with
UMA video memory

HP Compaq 6910p
Notebook PC with
discrete video
memory

Audio ● Stereo speakers

● Integrated monoaural microphone

● Headphone and microphone jacks

√ √

Modem ● 56K, v.92, data/fax modem (MDC1.5)

● Modem cable included in Brazil, the Czech
Republic, France, Greece, Hungary, Israel,
Latin America, Poland, Russia, Saudi Arabia,
Slovakia, Slovenia, South Africa, Turkey, and
the United Kingdom.

√ √

Ethernet ● Intel 10/100/1000 Ethernet with iAMT

● Network interface card (NIC) power-down

● S4/S5 wake on LAN (on AC power only)

√ √

Wireless Integrated wireless options by way of wireless
module

  

 Wireless local area network (WLAN) options:

● Broadcom 802.11a/b/g/n

● Broadcom 802.11a/b/g

● Broadcom 802.11b/g

● Intel 802.11a/b/g/n

● Intel 802.11a/b/g

● 3 WLAN antennas built into display panel

√ √

 Wireless wide area network (WWAN) options:

● Evolution-data optimized (EVDO) WWAN
module

● High-speed downlink packet access (HSPDA)
WWAN module

● Subscriber identity module (SIM)

√ √

 Wireless personal area network (WPAN) options:

● Bluetooth® 2.0 module + Blueflame module

● Supports no WPAN option

√ √

External media
card

● One Type I/II PC Card slot, 16-bit PCMCIA and
32-bit CardBus

● Media Card Reader (MS Duo adapters, plus
SD, MMC, MS, MSPro, and xD)

√ √

Ports ● 1394a port

● Docking connector

√ √
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Category Description HP Compaq 6910p
Notebook PC with
UMA video memory

HP Compaq 6910p
Notebook PC with
discrete video
memory

● Headphone connector

● Fast infrared port

● Microphone connector

● Primary battery connector

● RJ-11 modem port

● RJ-45 Ethernet port

● S-Video-out connector

● Smart AC adapter connector

● Travel battery connector

● USB ports (3)

● VGA port (Dsub 15-pin) supporting 1600 ×
1200 external resolution @ 75 Hz, hot plug/
unplug, and auto detect

Docking Docking support √ √

Keyboard/pointing
devices

● Spill-resistant keyboard with embedded
numeric keypad, TouchPad, and fingerprint
reader

● Taps enabled as default

● Two-way scrolling

● Windows Vista™ hardware Start button

√ √

Power
requirements

Primary batteries:

● 6-cell, 5.10-Ah, Li-ion battery (55-Wh)

● 6-cell, 2.20-Ah Li-ion battery (47-Wh)

Travel batteries:

● 12-cell Li-ion battery

● 8-cell Li-ion battery

AC adapter:

● 90-watt

● Localized cable plug support

● 3-wire plug with ground pin

● Supports multipin AC connector

√ √

Security ● Fingerprint reader

● HP 3D DriveGuard

● Security cable slot

√ √
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Category Description HP Compaq 6910p
Notebook PC with
UMA video memory

HP Compaq 6910p
Notebook PC with
discrete video
memory

● Smart card reader/bezel snap-in

● Trusted platform module (TPM) 1.2 on system
board

Operating system Preinstalled:

● Windows Vista Home Basic (32-bit)

● Windows Vista Business (32- and 64-bit)

● Windows® XP Professional

● FreeDOS

Certified:

● SuSe Linux Enterprise Desktop (SLED) 10

● Novell

√ √

Serviceability End-user replaceable parts:

● AC adapter

● Hard drive

● Memory module

● MultiBay II device

● Primary battery

● SIM

● WLAN module

● WWAN module

√ √

5



2 External component identification

Top components
Buttons, microphone, volume controls, and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista)
or in Standby (Windows XP), press the button briefly to exit
the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.
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Item Component Function

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel > System
and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2) Info button (select models only) Opens Info Center, which enables you to open various software
solutions.

(3) Wireless button Turns the wireless feature on or off, but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to establish
a wireless connection.

(4) Presentation button (select models only) Starts the presentation feature.

(5) Volume mute button (select models only) Mutes and restores speaker sound.

(6) Volume scroll zone (select models only) Adjusts speaker volume. Slide your finger to the left to decrease
volume and to the right to increase volume. You can also tap the
minus sign on the scroll zone to decrease volume, or tap the plus
sign on the scroll zone to increase volume.

(7) Internal microphone (select models only) Records sound.

(8) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a password
logon.

Top components 7



Keys

Item Component Function

(1) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) num lock key Enables numeric lock, turns on the embedded numeric keypad,
and turns on the num lock light.
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Pointing devices

Item Component Function

(1) Pointing stick (select models only) Moves the pointer and selects or activates items on the screen.

(2) Pointing stick buttons (select models only) Function like the left, middle, and right buttons on an external
mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the screen.

(4) Left and right TouchPad buttons* Function like the left and right buttons on an external mouse.

(5) TouchPad scroll zone Scrolls up or down.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Front components

Item Component Function

(1) Display release latch Opens the computer.

(2) Wireless light ● On: An integrated wireless device, such as a WLAN device,
a WWAN device, and/or a Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power rating
should be connected.

● Off: The computer is off or in Hibernation.

(4) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(5) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(6) Infrared port Provides wireless communication between the computer and an
optional IrDA-compliant device.

(7) Media Card Reader Supports Secure Digital (SD) Memory Cards and
MultiMediaCards.

(8) Speakers (2) Produce sound.
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Left-side components

Item Component Function

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(2) USB ports (2) Connect USB 1.1- and 2.0-compliant devices to the computer
using a standard USB cable, or connect an optional External
MultiBay II to the computer. The MultiBay II must also be
connected to an external power source.

(3) 1394 port (select models only) Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(5) Audio-out (headphone) jack Produces computer sound when connected to optional power
stereo speakers, headphones, ear buds, a headset, or television
audio.

(6) PC Card slot Supports optional Type I or Type II 32-bit (CardBus) or 16-bit PC
Cards.
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Rear components

Item Component Function

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) Battery bay Holds a battery.

(3) Power connector Connects an AC adapter or an optional power adapter.

(4) S-Video-out jack Connects an optional S-Video device such as a television, VCR,
camcorder, overhead projector, or video capture card.

(5) External monitor port Connects an external VGA monitor or projector.
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Right-side components

Item Component Function

(1) Smart card reader Supports optional smart cards and Java™ Cards.

(2) MultiBay II device Supports an optical disc. The type of optical drive varies by
model.

(3) USB port Connects USB 1.1- and 2.0-compliant devices to the computer
using a standard USB cable, or connects an optional External
MultiBay II to the computer. The MultiBay II must also be
connected to an external power source.

(4) RJ-45 (network) jack Connects an optional network cable.

(5) RJ-11 (modem) jack Connects the modem cable.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Docking connector (select models only) Connects an optional docking device.

(3) Battery latches (2) Release the battery from the battery bay.

(4) Vents (5) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(5) Accessory battery connector Connects an optional accessory battery.

(6) Hard drive bay Holds the hard drive.

(7) Bluetooth module compartment (select models
only)

Contains a Bluetooth device.

(8) Memory module compartment Contains the memory module slot.

(9) WLAN module compartment Contains the WLAN module slot.

CAUTION: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use
in the computer by the governmental agency that regulates
wireless devices in your country or region. If you replace the
module and then receive a warning message, remove the
module to restore computer functionality, and then contact
technical support through Help and Support.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components
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Item Description Spare part number

(1) Display assemblies (include wireless antenna transceivers and cables)

 14.1-inch, WXGA+ 446436-001

 14.1-inch, WXGA 446435-001

(2) Switch cover 446401-001

(3) Power button board (includes power button board cable) 446438-001

(4) Keyboards (include pointing stick and pointing stick cable)

 Belgium 446448-A41

 Brazil 446448-201

 The Czech Republic 446448-221

 Denmark 446448-081

 France 446448-051

 French Canada 446448-121

 Germany 446448-041

 Greece 446448-151

 Hungary 446448-211

 Iceland 446448-DD1

 International 446448-021

 Israel 446448-BB1

 Italy 446448-061

 Japan 446448-291

 Korea 446448-AD1

 Latin America 446448-161

 Norway 446448-091

 Portugal 446448-131

 Russia 446448-251

 Saudi Arabia 446448-171

 Slovakia 446448-231

 Slovenia 446448-BA1

 Spain 446448-071

 Sweden and Finland 446448-B71

 Switzerland 446448-111

 Taiwan 446448-AB1

 Thailand 446448-281

 Turkey 446448-141
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Item Description Spare part number

 The United Kingdom 446448-031

 The United States 446448-001

 Cable Kit (see Cable Kit on page 24 for more Cable Kit spare part information): 446406-001

(5a) Pointing stick cable

(5b) TouchPad cable

(5c) Modem module cable (includes RJ-11 connector)

(5d) Audio cable

(5e) Bluetooth module cable

(6) RTC battery 446400-001

(7) Microphone 446432-001

(8) Top cover (includes TouchPad, smart card reader, and fingerprint reader board) 446407-001

 Plastics Kit (see Plastics Kit on page 23 for more Plastics Kit spare part information): 446439-001

(9a) PC Card slot bezel

(9b) Hard drive cover

(9c) Memory module compartment cover

(9d) WLAN module compartment cover

(9e) Bluetooth module compartment cover

(10) PC Card assembly 446437-001

(11) Smart card reader board 446793-001

(12) Modem module (includes modem module cable) 446433-001

(13) Memory modules (667-MHz, PC2-5300, 1-DIMM)

 2048-MB 446430-001

 1024-MB 446429-001

 512-MB 446431-001

(14) WWAN modules

 Verizon EVDO WWAN module 418860-001

 Cingular HSPDA WWAN module 436638-001

 Vodafone HSPDA WWAN module 435098-001

(15) Fan assembly 446416-001

(16) System boards (include thermal material and alcohol pad)

 For use with heat sink spare part number 446446-001 (includes 128 MB of discrete video
memory)

446403-001

 For use with heat sink spare part number 446446-001 (includes 64 MB of discrete video
memory)

446404-001
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Item Description Spare part number

 For use with heat sink spare part number 446447-001 (video memory is shared with main
system memory)

446402-001

(17) Heat sinks

 For use with system boards spare part numbers 446403-001 and 446404-001 446446-001

 For use with system board spare part number 446402-001 446447-001

(18) Processors (include thermal material)

 Intel Core Duo T7700 2.4-GHz (4-MB L2 cache) 446443-001

 Intel Core Duo T7500 2.2-GHz (4-MB L2 cache) 446442-001

 Intel Core Duo T7300 2.0-GHz (4-MB L2 cache) 446441-001

 Intel Core Duo T7100 1.8-GHz (2-MB L2 cache) 446440-001

(19) Speaker assembly 446445-001

(20) MultiBay II eject assembly 446434-001

(21) Base enclosure (includes LED board, LED board cable, and rubber feet) 446397-001

 Rubber Kit–includes 6 computer feet (in 2 different sizes) and 2 base enclosure screw
covers

446680-001

(22) Hard drives (include hard drive bracket and connector)

 160-GB, 5400-rpm 446411-001

 120-GB, 5400-rpm 446413-001

 100-GB, 7200-rpm 446412-001

 80-GB, 7200-rpm 446415-001

 80-GB, 5400-rpm 446414-001

(23) MultiBay II devices (include bezel)

 DVD±RW and CD-RW Double-Layer Combo Drive 446409-001

 DVD/CD-RW Combo Drive 446410-001

 DVD-ROM Drive 446408-001

(24) Batteries

 6-cell, 5.10-Ah Li-ion 446399-001

 4-cell, 2.55-Ah Li-ion 446398-001

(25) WLAN modules

 802.11a/b/g/n Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441531-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,

441531-002
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Item Description Spare part number

the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory
Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 ● For use in Japan 441531-291

 802.11a/b/g/n Intel WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

441086-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany,
Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the
Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan

441087-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441088-003

 ● For use in Japan 441089-291

 802.11a/b/g Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441075-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New

441076-002
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Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South
Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 ● For use in Japan 441077-291

 802.11a/b/g Intel WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei,
Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India,
Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia,
Taiwan, the United States, and Vietnam

407576-001

 ● For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria,
the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt,
El Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland,
Ireland, Italy, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain,
Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and Uzbekistan

407576-002

 ● For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru,
Qatar, South Korea, Uruguay, and Venezuela

407576-003

 ● For use in Japan 407576-291

 802.11a/b/g Intel WLAN modules:

 ● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
the United States, Uruguay, Venezuela, and Vietnam

441082-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany,
Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the
Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan

441083-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441084-003

 ● For use in Japan 441085-291

 802.11b/g Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441090-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia & Herzegovina Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,

441091-002
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the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

 ● For use in Japan 441092-291

 ● For use in Thailand 409250-004

(26) Bluetooth module (includes Bluetooth module cable) 446405-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 446439-001

(1) PC Card slot bezel

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)

(3) Memory module compartment cover (includes 1 captive screw, secured by a C-clip)

(4) WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(5) Bluetooth module compartment cover (includes 1 captive screw, secured by a C-clip)
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Cable Kit

Item Description Spare part number

 Cable Kit: 446406-001

(1) Pointing stick cable

(2) TouchPad cable

(3) Audio cable

(4) Modem module cable (includes RJ-11 connector)

(5) Bluetooth module cable
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include frame and connector)

 160-GB, 5400-rpm 446411-001

 120-GB, 5400-rpm 446412-001

 100-GB, 7200-rpm 446412-001

 80-GB, 7200-rpm 446415-001

 80-GB, 5400-rpm 446414-001

(2) MultiBay II devices (include bezel)

 DVD±RW and CD-RW Double-Layer Combo Drive 446409-001

 DVD/CD-RW Combo Drive 446410-001

 DVD-ROM Drive 446408-001
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Miscellaneous parts
Description Spare part number

HP Smart Adapter AC adapters

90-watt non-PFC Smart Adapter 418873-001

90-watt PFC Smart Adapter 418875-001

External MultiBay II 366143-001

External MultiBay II power cable and stand 366144-001

HP Extended Life Battery 367456-001

HP Docking Station 374803-001

HP Docking Station Miscellaneous Plastics Kit 380089-001

Label Kit 446419-001

MultiBay II 8X DVD-ROM Drive 373314-001

MultiBay II 24X DVD/CD-RW Combo Drive 373315-001

Nylon carrying case 325814-001

Power cords

For use in the United States 403811-001

For use in Australia 403811-011

For use in Europe, the Middle East, and Africa 403811-021

For use in the United Kingdom 403811-031

For use in Italy 403811-061

For use in Denmark 403811-081

For use in Switzerland 403811-111

For use in Japan 403811-291

For use in the People's Republic of China 403811-AA1

For use in Taiwan 403811-AB1

For use in Korea 403811-AD1

For use in Israel 403811-BB1

For use in India 403811-D61

Screw Kit

● Phillips PM3.0×3.0 screw

● Phillips PM2.5×13.0 captive screw

● Phillips PM2.5×6.0 screw

● Phillips PM2.5×5.0 screw

● Phillips PM2.5×4.0 screw

446444-001
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Description Spare part number

● Phillips PM2.5×3.0 screw

● Phillips PM2.0×10.0 captive screw

● Phillips PM2.0×6.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.5×11.0 captive screw

● Torx T8M2.5×11.0 screw

● Torx T8M2.5×7.0 screw

Sequential part number listing
Spare part
number

Description

325814-001 Nylon carrying case

366143-001 External MultiBay II

366144-001 External MultiBay II power cable and stand

367456-001 HP Extended Life Battery

373314-001 MultiBay II 8X DVD-ROM Drive

373315-001 MultiBay II 24X DVD/CD-RW Combo Drive

374803-001 HP Docking Station

380089-001 HP Docking Station Miscellaneous Plastics Kit

403811-001 Power cord for use in the United States

403811-011 Power cord for use in Australia

403811-021 Power cord for use in Europe, the Middle East, and Africa

403811-031 Power cord for use in the United Kingdom

403811-061 Power cord for use in Italy

403811-081 Power cord for use in Denmark

403811-111 Power cord for use in Switzerland

403811-291 Power cord for use in Japan

403811-AA1 Power cord for use in the People's Republic of China

403811-AB1 Power cord for use in Taiwan

403811-AD1 Power cord for use in Korea

403811-BB1 Power cord for use in Israel

403811-D61 Power cord for use in India
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Spare part
number

Description

407576-001 802.11a/b/g Broadcom WLAN module for use in for use in Antigua and Barbuda, Argentina, Australia, the
Bahamas, Barbados, Brunei, Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India,
Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, and
Vietnam

407576-002 802.11a/b/g Broadcom WLAN module for use in for use in Aruba, Austria, Azerbaijan, Bahrain, Belgium,
Bermuda, Brazil, Bulgaria, the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark,
Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy,
Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway,
Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and Uzbekistan

407576-003 802.11a/b/g Broadcom WLAN module for use in for use in Ecuador, Haiti, Honduras, Pakistan, the People's
Republic of China, Peru, Qatar, South Korea, Uruguay, and Venezuela

407576-291 802.11a/b/g Broadcom WLAN module for use in Japan

409250-004 802.11b/g Broadcom WLAN module for use in Thailand

418860-001 Verizon EVDO WWAN module

418873-001 90W non-PFC HP Smart Adapter

418875-001 90W PFC HP Smart Adapter

435098-001 Vodafone HSPDA WWAN module

436638-001 Cingular HSPDA WWAN module

441075-001 802.11a/b/g Broadcom WLAN module for use in for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

441076-002 802.11a/b/g Broadcom WLAN module for use in for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

441077-291 802.11a/b/g Broadcom WLAN module for use in Japan

441082-001 802.11a/b/g Intel WLAN module for use in for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441083-002 802.11a/b/g Intel WLAN module for use in for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria,
Croatia, Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco,

28 Chapter 3   Illustrated parts catalog



Spare part
number
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the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441084-003 802.11a/b/g Intel WLAN module for use in ROW

441085-291 802.11a/b/g Intel WLAN module for use in Japan

441086-001 802.11a/b/g/n Intel WLAN module for use in for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

441087-002 802.11a/b/g/n Intel WLAN module for use in for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria,
Croatia, Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco,
the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441088-003 802.11a/b/g/n Intel WLAN module for use in for use in Australia, New Zealand, Pakistan, the People's Republic
of China, and South Korea

441089-291 802.11a/b/g/n Intel WLAN module for use in Japan

441090-001 802.11b/g Broadcom WLAN module for use in for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

441091-002 802.11b/g Broadcom WLAN module for use in For use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the
People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441092-291 802.11b/g Broadcom WLAN module for use in Japan

441531-001 802.11a/b/g/n Broadcom WLAN module for use in for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

441531-002 802.11a/b/g/n Broadcom WLAN module for use in for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea,
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Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast,
Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
& Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441531-291 802.11a/b/g/n Broadcom WLAN module for use in Japan

446397-001 Base enclosure (includes LED board, LED board cable, and rubber feet)

446398-001 4-cell, 2.55-Ah battery

446399-001 6-cell, 5.10-Ah Li-ion battery

446400-001 RTC battery

446401-001 Switch cover

446402-001 System board for use with heat sink spare part number 446447-001 (video memory is shared with main system
memory)

446403-001 System board for use with heat sink spare part number 446446-001 (includes 128 MB of discrete video
memory)

446404-001 System board for use with heat sink spare part number 446446-001 (includes 64 MB of discrete video memory)

446405-001 Bluetooth module (includes Bluetooth module cable)

446406-001 Cable Kit (see Cable Kit on page 24 for more Cable Kit spare part information)

446407-001 Top cover (includes TouchPad, smart card reader, and fingerprint reader board)

446408-001 MultiBay II DVD-ROM Drive

446409-001 DVD±RW and CD-RW Double-Layer Combo Drive

446410-001 DVD/CD-RW Combo Drive

446411-001 160-GB, 5400-rpm hard drive (includes hard drive bracket and connector)

446412-001 100-GB, 7200-rpm hard drive (includes hard drive bracket and connector)

446413-001 120-GB, 5400-rpm hard drive (includes hard drive bracket and connector)

446414-001 80-GB, 7200-rpm hard drive (includes hard drive bracket and connector)

446415-001 80-GB, 5400-rpm hard drive (includes hard drive bracket and connector)

446416-001 Fan assembly

446419-001 Label Kit

446429-001 1024-MB memory module (667-MHz, PC2-5300, 1-DIMM)

446430-001 2048-MB memory module (667-MHz, PC2-5300, 1-DIMM)

446431-001 512-MB memory module (667-MHz, PC2-5300, 1-DIMM)

446432-001 Microphone
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Spare part
number

Description

446433-001 Modem module (includes modem module cable)

446434-001 MultiBay II eject assembly

446435-001 14.1-inch, WXGA display assembly (includes wireless antenna transceivers and cables)

446436-001 14.1-inch, WXGA+ display assembly (includes wireless antenna transceivers and cables)

446437-001 PC Card assembly

446438-001 Power button board (includes power button board cable)

446439-001 Plastics Kit (see Plastics Kit on page 23 for more Plastics Kit spare part information)

446440-001 Intel Core Duo T7100 1.8-GHz processor (2-MB L2 cache)

446441-001 Intel Core Duo T7300 2.0-GHz processor (4-MB L2 cache)

446442-001 Intel Core Duo T7500 2.2-GHz processor (4-MB L2 cache)

446443-001 Intel Core Duo T7700 2.4-GHz processor (4-MB L2 cache)

446444-001 Screw Kit

446445-001 Speaker assembly

446446-001 Heat sink for use with system board spare part numbers 446403-001 and 446404-001

446447-001 Heat sink For use with system board spare part number 446402-001

446448-001 Keyboard for use in the United States

446448-021 Keyboard for use in the Netherlands and Europe

446448-031 Keyboard for use in the United Kingdom

446448-041 Keyboard for use in Germany

446448-051 Keyboard for use in France

446448-061 Keyboard for use in Italy

446448-071 Keyboard for use in Spain

446448-081 Keyboard for use in Denmark

446448-091 Keyboard for use in Norway

446448-111 Keyboard for use in Switzerland

446448-121 Keyboard for use in French Canada

446448-131 Keyboard for use in Portugal

446448-141 Keyboard for use in Turkey

446448-151 Keyboard for use in Greece

446448-161 Keyboard for use in Latin America

446448-171 Keyboard for use in Saudi Arabia

446448-201 Keyboard for use in Brazil

446448-211 Keyboard for use in Hungary

446448-221 Keyboard for use in the Czech Republic
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Spare part
number

Description

446448-231 Keyboard for use in Slovakia

446448-251 Keyboard for use in Russia

446448-281 Keyboard for use in Thailand

446448-291 Keyboard for use in Japan

446448-A41 Keyboard for use in Belgium

446448-AB1 Keyboard for use in Taiwan

446448-AD1 Keyboard for use in Korea

446448-B71 Keyboard for use in Sweden

446448-BA1 Keyboard for use in Slovenia

446448-BB1 Keyboard for use in Israel

446448-DD1 Keyboard for use in Iceland

446680-001 Rubber Kit–includes 6 computer feet (in 2 different sizes) and 2 base enclosure screw covers

446793-001 Smart card reader board
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 58).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 72 screws, in 15 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.
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Battery

Description Spare part number

6-cell, 5.1-Ah, Li-ion battery 446399-001

4-cell, 2.55-Ah, Li-ion battery 446398-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Display inverter
NOTE: If it has been determined that the display inverter is the component that must be replaced to
complete the computer repair, the display assembly does not have to be removed. Follow the procedures
in this section to replace the display inverter. For information on replacing the display assembly and the
display hinges, see Display assembly on page 69.

Description Spare part number

Display inverter (includes 2-sided tape) 446418-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel.

4. Remove the two Torx T8M2.5×6.0 screws (2) that secure the bottom edge of the display bezel to
the display enclosure.

5. Flex the inside edges of the left and right sides (1) and the bottom edge (2) of the display bezel
until the bezel disengages from the display enclosure.
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6. Release the bottom edge of the display bezel (3) from the display assembly.

7. Release the inverter (1) from the display enclosure as far as the display panel cable and backlight
cable allow.

8. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

9. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Hard drive

Description Spare part number

160-GB, 5400-rpm hard drive 446411-001

120-GB, 5400-rpm hard drive 446413-001

100-GB, 7200-rpm hard drive 446412-001

80-GB, 7200-rpm hard drive 446415-001

80-GB, 5400-rpm hard drive 446414-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.

3. Lift the right side of the hard drive cover (2), swing it to left, and remove the cover. The hard drive
cover is included in the Plastics Kit, spare part number 446439-001.

4. Loosen the Phillips PM2.5×13.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.
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6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×3.0 hard drive
bracket screws (1) from each side of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Component replacement procedures 45



Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 446680-001. There are 6 rubber feet in 2 different sizes. The feet attach to the base
enclosure in the locations illustrated below.

Bluetooth module

Description Spare part number

Bluetooth (includes Bluetooth module cable) 446405-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the Bluetooth® module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the Bluetooth module compartment
cover to the computer.
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3. Lift the cover (2) straight up to remove it. The Bluetooth module compartment cover is included in
the Plastics Kit, spare part number 446439-001.

4. Remove the Bluetooth module (1) from the computer.

5. Disconnect the Bluetooth module cable (2) from the module.

6. Remove the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.
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Expansion memory module

Description Spare part number

2048-MB (667-MHz, PC2-5300, 1-DIMM) 446430-001

1024-MB (667-MHz, PC2-5300, 1-DIMM) 446429-001

512-MB (667-MHz, PC2-5300, 1-DIMM) 446431-001

Before removing the expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the expansion memory module:

1. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the memory module compartment
cover to the computer.

2. Lift the right side of the cover (2), swing it to the right, and remove the cover. The memory module
compartment cover is included in the Plastics Kit, spare part number 446439-001.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the expansion memory module.
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WLAN module
CAUTION: The WLAN module and WWAN module are not interchangeable.

Description Spare part number

802.11a/b/g/n Broadcom WLAN modules:  

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441531-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the
People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St.
Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

441531-002

● For use in Japan 441531-291

802.11a/b/g/n Intel WLAN modules:  

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441087-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441088-003

● For use in Japan 441089-291

802.11a/b/g Broadcom WLAN modules:  

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441075-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the

441076-002

50 Chapter 4   Removal and replacement procedures



Description Spare part number

Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

● For use in Japan 441077-291

802.11a/b/g Intel WLAN modules:  

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

441082-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441083-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441084-003

● For use in Japan 441085-291

802.11a/b/g Broadcom WLAN modules:  

● For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei,
Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia,
Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States,
and Vietnam

407576-001

● For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman
Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El Salvador, Estonia,
Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy, Jordan, Latvia,
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway,
Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
the United Kingdom, and Uzbekistan

407576-002

● For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru, Qatar,
South Korea, Uruguay, and Venezuela

407576-003

● For use in Japan 407576-291

802.11b/g Broadcom WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441090-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441091-002

● For use in Japan 441092-291

● For use in Thailand 409250-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the WLAN module:

1. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the WLAN module compartment
cover to the computer.
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2. Lift the front edge of the WLAN module compartment cover (2), swing it toward the back of the
computer, and remove the cover. The WLAN module compartment cover is included in the Plastics
Kit, spare part number 446439-001.

3. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is connected
to the middle terminal on the WLAN module.

4. Remove the two Phillips PM2.0×3.0 screws (3) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

5. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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MultiBay II device

Description Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 446409-001

DVD/CD-RW Combo Drive 446410-001

DVD-ROM Drive 446408-001

Before removing the MultiBay II device, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the optical drive:

1. Position the computer with the left side toward you.

2. If present, remove the Phillips PM2.5×5.0 screw (1) that secures the MultiBay II device to the
computer.

3. Push in on the right side of the MultiBay II device (2). (The MultiBay II device partially ejects from
the MultiBay II.)

4. Remove the MultiBay II device (3) from the computer.

Reverse this procedure to install a MultiBay II device.
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Keyboard

For use in: Spare part number For use in: Spare part number

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

Korea

Latin America

446448-A41

446448-201

446448-221

446448-081

446448-051

446448-121

446448-041

446448-151

446448-211

446448-DD1

446448-BB1

446448-061

446448-291

446448-AD1

446448-161

The Netherlands and Europe

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

446448-021

446448-091

446448-131

446448-251

446448-171

446448-231

446448-BA1

446448-071

446448-B71

446448-111

446448-AB1

446448-281

446448-141

446448-031

446448-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the keyboard:

1. Position the computer with the front toward you.
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2. Loosen the three Torx T8M2.5×11.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.

6. Lift the rear edge of the keyboard (2) and swing it toward you until it rests on the palm rest.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.
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8. Release the ZIFconnector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

9. Remove the keyboard.

10. If it is necessary to replace the pointing stick cable, turn the keyboard upside down, with the bottom
of the keyboard toward you.

11. Release the ZIF connector (1) to which the pointing stick cable is attached, and disconnect the
cable (2) from the keyboard. The pointing stick cable is included in the Cable Kit, spare part number
446406-001.

Reverse this procedure to install the keyboard.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery (includes 2-sided tape) 446400-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Release the keyboard (see Keyboard on page 55).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Remove the RTC battery cable (2) from the system board.

3. Remove the RTC battery (3) from the clip built into the top cover.

Reverse this procedure to install the RTC battery.
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Primary memory module

Description Spare part number

2048-MB (667-MHz, PC2-5300, 1-DIMM) 446430-001

1024-MB (667-MHz, PC2-5300, 1-DIMM) 446429-001

512-MB (667-MHz, PC2-5300, 1-DIMM) 446431-001

Before removing the primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Release the keyboard (see Keyboard on page 55).

Remove the primary memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the primary memory module.
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Modem module

Description Spare part number

Modem module (includes modem module cable) 446433-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Release the keyboard (see Keyboard on page 55).

Remove the modem module:

1. Remove the two Phillips PM2.0×6.0 screws (1) that secure the modem module to the computer.

2. Lift the modem module (2) straight up to disconnect it from the system board.

3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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WWAN module
CAUTION: The WWAN module and WLAN module are not interchangeable.

Description Spare part number

Verizon EVDO WWAN module 418860-001

Cingular HSPDA WWAN module 436638-001

Vodafone HSPDA WWAN module 435098-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Release the keyboard (see Keyboard on page 55).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect installation.
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Reverse this procedure to install the WWAN module.

Switch cover

Description Spare part number

Switch cover 446401-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the keyboard (see Keyboard on page 55).

Remove the switch cover:

1. Close the computer.

2. Turn the computer upside down, with the rear panel toward you.

3. Remove the two Torx T8M2.5×11.0 screws (1) and the three Phillips PM2.0×2.0 screws (2) that
secure the switch cover to the computer.

4. Turn the computer right-side up, with the front toward you.

5. Open the computer as far as possible.

6. Disconnect the power button board cable (1) from the system board.

7. Release the ZIF connector to which the LED board cable is attached, and disconnect the LED
board cable (2) from the system board.
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8. Remove the switch cover (3) by lifting it straight up until it disengages from the computer.

9. If it is necessary to replace the power button board, turn the switch cover upside down, with the
bottom of the switch cover toward you.

10. Remove the Phillips PM2.5×3.0 screw (1) that secures the power button board to the switch cover.

11. Remove the power button board (2). The power button board is available using spare part number
446438-001.

Reverse this procedure to install the power button board and switch cover.
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Fan assembly

Description Spare part number

Fan assembly 446416-001

Before removing the fan assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the keyboard (see Keyboard on page 55).

6. Remove the switch cover (see Switch cover on page 62).

Remove the fan assembly:

1. Disconnect the fan cable (1) from the system board.

2. Remove the Phillips PM2.5×7.0 screw (2) that secures the fan assembly to the computer.

3. Remove the fan assembly (3).

Reverse this procedure to install the fan assembly.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software applications. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Heat sink
NOTE: All heat sink spare part kits include thermal material.

Description Spare part number

For use with system boards spare part numbers 446403-001 and 446404-001 446446-001

For use with system board spare part number 446402-001 446447-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the keyboard (see Keyboard on page 55).

6. Remove the switch cover (see Switch cover on page 62).

7. Remove the fan assembly (see Fan assembly on page 64).

Remove the heat sink:

1. Loosen the four Phillips PM2.0×10.0 screws (1) that secure the heat sink to the system board.
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2. Remove the heat sink (3) by lifting it straight up.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1)
and the processor (2), and system board components (3) and (4) each time the heat sink is
removed. Thermal material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include thermal material.

Description Spare part number

Intel Core Duo T7700 2.4-GHz processor (4-MB L2 cache) 446443-001

Intel Core Duo T7500 2.2-GHz processor (4-MB L2 cache) 446442-001

Intel Core Duo T7300 2.0-GHz processor (4-MB L2 cache) 446441-001

Intel Core Duo T7100 1.8-GHz processor (2-MB L2 cache) 446440-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Release the keyboard (see Keyboard on page 55).

6. Remove the switch cover (see Switch cover on page 62).

7. Remove the fan assembly (see Fan assembly on page 64).

8. Remove the heat sink (see Heat sink on page 65).

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed on
the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly

Description Spare part number

14.1-inch, WXGA+ display assembly (includes wireless antenna transceivers and cables) 446436-001

14.1-inch, WXGA display assembly (includes wireless antenna transceivers and cables) 446435-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 50).

6. Remove the following components:

a. Keyboard (see Keyboard on page 55)

b. Switch cover (see Switch cover on page 62)

7. Disconnect the wireless antenna cables from the WWAN module (see WWAN module
on page 61).

Remove the display assembly:

1. Turn the computer upside down, with the rear panel toward you.
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2. Remove the following screws:

(1) Two Torx T8M2.5×11.0 screws

(2) Two Torx T8M2.5×7.0 screws

(3) One Phillips PM2.5×5.0 screw

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Disconnect the display panel cable (1) from the system board.

6. Remove the wireless antenna cables from the routing channels (2) and clips (3) built into the top
cover.

7. Remove the two Torx T8M2.5×7.0 screws (1) that secure the display assembly to the computer.
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8. Lift the display assembly straight up and remove it (2).

9. If it is necessary to replace the display hinges, remove the following:

(1) Two rubber screw covers on the display bezel top edge

(2) Two rubber screw covers one the display bezel bottom edge

(3) Four Torx T8M2.5×6.0 screws

10. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.
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11. Remove the display bezel (3). The display bezel is available using spare part number
446420-001.

12. Remove the two Phillips PM2.5×4.0 screws (1) and the two Phillips PM2.5×6.0 screws (2) that
secure the display hinge to the display panel.

13. Remove the display hinges (3). The left and right display hinges are available using spare part
number 446417-001.

CAUTION: When installing the display assembly, be sure that the wireless antenna cable routed out
of the display left hinge is routed and arranged properly. This antenna cable has a grounding sleeve
(1) and an exposed section of cable (2). The grounding sleeve must completely cover the exposed
section of cable, and must be in contact with the grounding clip (3) on the left display hinge.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and WWAN
performance.
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CAUTION: Be sure that the 3 wireless antenna cables routed out of the display right hinge are also
routed and arranged properly. Each antenna cable has a metallic grounding sleeve (1) that must
completely cover the exposed section of cable (2). A piece of metallic grounding tape (3) must be used
to secure the cables to the flat section (4) of the display right hinge. This grounding tape must make
contact with the grounding sleeves.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and WWAN
performance.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover 446407-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. MultiBay II device (see MultiBay II device on page 54)

c. Keyboard (see Keyboard on page 55)

d. Switch cover (see Switch cover on page 62)

e. Display assembly (see Display assembly on page 69)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following:

(1) Two base enclosure rubber screw covers. The base enclosure rubber screw covers are included
in the Rubber Kit, spare part number 446680-001.

(2) Nine Torx T8M2.5×11.0 screws.

(3) One Torx T8M2.5×7.0 screw.

3. Turn the computer right-side up, with the front toward you.

4. Disconnect the following cables from the system board:

(1) TouchPad cable

(2) Fingerprint reader board cable

(3) Smart card reader board cable

5. Remove the microphone receiver (1) from the clip built into the top cover.
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6. Disconnect the microphone cable (2) from the system board.

7. Remove the two Torx T8M2.5×7.0 screws that secure the top cover to the computer.

8. Lift the rear edge of the top cover (1) until it disengages from the base enclosure.

9. Swing the rear edge (2) of the top cover toward you until it rests at an angle.

10. Lift the top cover (3) straight up and remove it.
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Reverse this procedure to install the top cover.

Smart card reader board

Description Spare part number

Smart card reader board 446793-001

Before removing the smart card reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. MultiBay II device (see MultiBay II device on page 54)

c. Keyboard (see Keyboard on page 55)

d. Switch cover (see Switch cover on page 62)

e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 74)

Remove the smart card reader board:

1. Remove the three Phillips PM2.5×4.0 screws (1) that secure the smart card reader board and the
PC Card assembly to the base enclosure.

2. Remove the smart card reader board and the PC Card assembly (2).
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3. If it is necessary to replace the PC Card assembly, remove the PC Card assembly from the smart
card reader board by disengaging the hooks (1) on the PC Card assembly from the tabs on the
smart card reader board.

4. Remove the PC Card assembly (2) from the smart card reader board. The PC Card assembly is
available using spare part number 446437-001.

5. If it is necessary to replace the microphone and cable, disconnect the microphone cable (1) from
the system board.

6. Remove the microphone and cable (2). The microphone is available using spare part number
446432-001.

Reverse this procedure to install the smart card reader board, PC Card assembly, and microphone.
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Speaker assembly

Description Spare part number

Speaker assembly 446445-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. MultiBay II device (see MultiBay II device on page 54)

c. Keyboard (see Keyboard on page 55)

d. Switch cover (see Switch cover on page 62)

e. Display assembly (see Display assembly on page 69)

f. Top cover (see Top cover on page 74)

Remove the speaker assembly:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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System board

Description Spare part number

System board for use with heat sink spare part number 446446-001 (includes 128 MB of discrete
video memory)

446403-001

System board for use with heat sink spare part number 446446-001 (includes 64 MB of discrete
video memory)

446404-001

System board for use with heat sink spare part number 446447-001 (video memory is shared with
main system memory)

446402-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Bluetooth module (see Bluetooth module on page 46)

c. MultiBay II device (see MultiBay II device on page 54)

d. Keyboard (see Keyboard on page 55)

e. Switch cover (see Switch cover on page 62)

f. Fan assembly (see Fan assembly on page 64)

g. Heat sink (see Heat sink on page 65)

h. Display assembly (see Display assembly on page 69)

i. Top cover (see Top cover on page 74)

j. Smart card reader board (see Smart card reader board on page 77)

k. Microphone (see Smart card reader board on page 77)

l. Speaker assembly (see Speaker assembly on page 79)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● SIM (see SIM on page 41)

● Memory modules (see Expansion memory module on page 48 and Primary memory module
on page 59)

● WLAN module (see WLAN module on page 50)
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● RTC battery (see RTC battery on page 58)

● WWAN module (see WWAN module on page 61)

● Processor (see Processor on page 67)

● Smart card reader board (see Smart card reader board on page 77)

● Modem module (see Modem module on page 60)

Remove the system board:

1. Turn the computer upside down, with the front toward you.

2. Remove the two Phillips PM2.0×6.0 screws, on each side of the hard drive connector, that secure
the system board to the base enclosure.

3. Turn the computer right-side up, with the front toward you.

4. Remove the audio cable (1) from the space between the base enclosure and the system board.
The audio board cable is available in the Cable Kit, spare part number 446406-001.
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5. Disconnect the Bluetooth module cable (2) from the system board and remove the cable from the
base enclosure. The Bluetooth module cable is available in the Cable Kit, spare part number
446406-001.

6. Disconnect the modem module cable (1) from the system board. The modem module cable is
available in the Cable Kit, spare part number 446406-001.

7. Release the ZIF connector (2) to which the LED board cable is attached, and disconnect the LED
board cable (3) from the system board.
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8. Remove the four Phillips PM2.5×4.0 screws (1) and the two Phillips PM2.0×3.0 screws (2) that
secure the system board to the base enclosure.

9. Use the optical drive connector (1) to lift the right side of the system board (2) until it rests at an
angle.

10. Remove the system board (3) by sliding it away from the base enclosure at an angle.
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11. If it is necessary to replace the audio cable, disconnect the audio cable from the 3 audio connectors
on the system board. The audio cable is included in the Cable Kit, spare part number
446406-001.

12. If it is necessary to replace the modem module cable, remove the RJ-11 connector (1) from the
clip built into the base enclosure.

13. Remove the modem module cable (2) from the clips and routing channels built into the base
enclosure. The modem module cable is included in the Cable Kit, spare part number 446406-001.

Reverse the preceding procedure to install the system board.
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MultiBay II eject assembly

Description Spare part number

MultiBay II eject assembly 446434-001

Before removing the MultiBay II eject assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Bluetooth module (see Bluetooth module on page 46)

c. MultiBay II device (see MultiBay II device on page 54)

d. Keyboard (see Keyboard on page 55)

e. Switch cover (see Switch cover on page 62)

f. Fan assembly (see Fan assembly on page 64)

g. Heat sink (see Heat sink on page 65)

h. Display assembly (see Display assembly on page 69)

i. Top cover (see Top cover on page 74)

j. Smart card reader board (see Smart card reader board on page 77)

k. Microphone (see Smart card reader board on page 77)

l. Speaker assembly (see Speaker assembly on page 79)

m. System board (see System board on page 80)

Remove the MultiBay II eject assembly:

1. Remove the Phillips PM2.0×6.0 screw (1) that secures the MultiBay II eject assembly to the base
enclosure.
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2. Remove the MultiBay II eject assembly (2) from the base enclosure.

Reverse this procedure to install the MultiBay II eject assembly.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

88 Chapter 5   Computer Setup



Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the
system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup
by turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions
available in Embedded Security for ProtectTools. For more information, refer to
the ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase
cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system or on any optional
MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer or to an
optional docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.
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Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Height (front to back) 2.91 to 3.37 cm 1.15 to 1.33 in

Width 33.1 cm 13.03 in

Depth 23.9 cm 9.41 in

Weight (with optical drive, hard drive, and battery) 2.24 kg 4.93 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 21.3 cm 8.40 in

Width 28.5 cm 11.20 in

Diagonal 35.8 cm 14.10 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1440 × 900

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.5 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)

94 Chapter 6   Specifications



Hard drive specifications
 160-GB* 120-GB* 100-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 312,560,640 234,420,480 195,350,400 156,280,320

Disc rotational speed 5400 rpm 5400 rpm 7200 rpm 7200 and 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Primary 6-cell, Li-ion battery specifications
 Metric U.S.

Dimensions

Height 2.0 cm 0.79 in

Width 20.3 cm 7.99 in

Depth 5.3 cm 2.09 in

Weight 0.34 kg 0.75 lb

Energy

Voltage 14.4 V

Amp-hour capacity 2.2 Ah and 2.55 Ah

Watt-hour capacity 47 Wh and 55 Wh

Temperature

Operating 5°C to 45°C 41°F to 113°F

Nonoperating 0°C to 60°C 32°F to 140°F
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DVD±RW and CD-RW Double-Layer Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.

System interrupt specifications 101



System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

System I/O address specifications 103



System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part
number 446444-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 5 5.0 mm 2.0mm 5.0 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover by
C-clips)

(2) One screw that secures the Bluetooth module compartment cover to the computer (screw is captured
on the cover by a C-clip)

(3) One screw that secures the memory module compartment cover to the computer (screw is captured
on the cover by a C-clip)

(4) One screw that secures the WLAN module compartment cover to the computer (screw is captured
on the cover by a C-clip)
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Phillips PM2.5×13.0 captive screw

Color Quantity Length Thread Head diameter

Silver 1 13.0 mm 2.5 mm 6.0 mm

Where used: One screw that secures the hard drive to the computer
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Phillips PM3.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 4 3.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.0×3.0 screw
Color Quantity Length Thread Head diameter

Silver 6 3.0 mm 2.0 mm 4.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the WWAN module to the system board
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Where used: 2 screws that secure the system board to the base enclosure
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Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 2 5.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the MultiBay II device to the computer

(2) One screw that secures the display assembly to the computer
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Torx T8M2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 11.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the keyboard to the computer
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Torx T8M2.5×11.0 screw

Color Quantity Length Thread Head diameter

Black 13 11.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the switch cover to the computer

(2) Two screws that secure the display assembly to the computer

Where used: 9 screws that secure the top cover to the computer
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 5 6.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the modem module to the system board

Where used: 2 screws that secure the system board to the base enclosure
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Where used: One screw that secures the MultiBay II eject assembly to the base enclosure
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Phillips PM2.0×2.0 broad head screw

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 7.0 mm

Where used: 3 screws that secure the switch cover to the computer
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Phillips PM2.5×3.0 screw

Color Quantity Length Thread Head diameter

Silver 2 3.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the power button board to the switch cover
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Torx T8M2.5×7.0 screw

Color Quantity Length Thread Heat width

Black 8 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the fan assembly to the computer

Where used: 2 screws that secure the display assembly to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: One screw that secures the top cover to the computer

Where used: 2 screws that secure the top cover to the computer
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Phillips PM2.0×10.0 captive screw

Color Quantity Length Thread Head diameter

Silver 4 10.0 mm 2.0mm 5.0 mm

Where used: 4 captive screws that secure the heat sink to the computer
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Phillips PM2.5×6.0 screw

Color Quantity Length Thread Head diameter

Silver 6 6.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the display bezel to the display assembly

Where used: 2 screws that secure the display hinges to the display panel
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the display hinges to the display panel
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8 Backup and recovery

Backup and recovery in Windows Vista
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R discs (purchased separately).

NOTE: Read-write discs, such as CD-RW and DVD±RW discs, are not compatible with HP
Backup & Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be prompted
to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.
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With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.
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To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup & Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.

Backup and recovery in Windows XP
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R discs (purchased separately).

NOTE: Read-write discs, such as CD-RW and DVD±RW discs, are not compatible with HP
Backup and Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the system
(Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.
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3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy
them to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.
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NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.

130 Chapter 8   Backup and recovery



Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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S-Video-out

Pin Signal

1 S-VHS color (C) signal

2 Composite video signal

3 S-VHS intensity (Y) signal

4 S-VHS color ground

5 TV-CD

6 S-VHS intensity ground

7 Composite video ground

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port 11

A
AC adapter, spare part

numbers 26,  28
accessory battery connector 14
antennae, disconnecting 53,  61
audio cable

illustrated 24
removal 84

audio, product description 3
audio-in jack

location 11
pin assignments 134

audio-out jack
location 11
pin assignments 134

B
backing up 123,  129
backup

files and folders 124,  130
hard drive 125,  130
modifications made to the

system 126,  131
scheduling 126,  131

base enclosure, spare part
number 19,  30

battery
location 14
removal 40
spare part numbers 19,  30, 

40
specifications 96

battery bay 12,  14
battery latch 14
battery light 10

Bluetooth module
removal 46
spare part number 22,  30, 

46
Bluetooth module cable,

illustrated 24
Bluetooth module

compartment 14
Bluetooth module compartment

cover
illustrated 23
removal 47

boot options 91
boot order 91
bottom components 14
buttons

info 7
power 6
presentation 7
volume mute 7
wireless 7

C
Cable Kit

contents 24
spare part number 18,  24, 

30
cables, service considerations 34
carrying case, spare part

number 26,  27
chipset, product description 1
CMOS clearing 38
components

bottom 14
buttons 6
fingerprint reader 6
front 10
keys 8
left-side 11
pointing devices 9

rear 12
right-side 13
top 6

computer feet
locations 46
spare part number 19,  32, 

46
Computer Setup

accessing 87
Diagnostics menu 90
File menu 89
navigating and selecting 88
restoring factory settings 88
Security menu 90
System Configuration

menu 91
using 88

computer specifications 93
connectors

accessory battery 14
docking 14
power 12
service considerations 34

creating recovery points 126, 
131

D
Diagnostics menu 90
Disk Sanitizer 90
diskette drive

precautions 34
product description 2

display assembly
removal 69
spare part numbers 17,  31, 

69
display bezel

release 42
removal 71
spare part number 72
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display component recycling 140
display hinge

removal 71
spare part number 72

display inverter
removal 42
spare part number 42

display release latch 10
display specifications 94
docking connector 14
docking support, product

description 4
drive light 10
DriveLock password 90
drives, boot order 91
drives, preventing damage 34
DVD-ROM Drive

precautions 34
removal 54
spare part number 19,  25, 

30,  54
specifications 99

DVD/CD-RW Combo Drive
precautions 34
removal 54
spare part number 19,  25, 

30,  54
specifications 98

DVD±RW and CD-RW Combo
Drive

precautions 34
removal 54
spare part number 19,  25, 

30,  54
specifications 97

E
electrostatic discharge 35
Ethernet, product description 3
Execution Disable 91
external media cards, product

description 3
external monitor port

location 12
pin assignments 135

External MultiBay II power cable
and stand, spare part
number 26,  27

External MultiBay II, spare part
number 26,  27

F
fan assembly

removal 64
spare part number 18,  30, 

64
feet

locations 46
spare part number 19,  32, 

46
File menu 89
fingerprint reader 7
fn key 8
front components 10
function keys 8

G
graphics, product description 1
grounding equipment and

methods 37

H
hard drive

location 14
precautions 34
product description 2
removal 44
spare part numbers 19,  25, 

30,  44
specifications 95

hard drive backup 125,  130
hard drive bay 14
hard drive bracket, removal 45
hard drive cover

illustrated 23
removal 44

hard drive recovery 127,  132
hard drive test 90
headphone jack

location 11
pin assignments 134

heat sink
removal 65
spare part numbers 19,  31, 

65
hinge

removal 71
spare part number 72

HP Docking Stand Miscellaneous
Plastics Kit, spare part
number 26,  27

HP Docking Stand, spare part
number 26,  27

HP Extended Life Battery, spare
part number 26,  27

I
I/O address specifications 102
info button 7
infrared port 10
interrupt specifications 101
inverter

removal 42
spare part number 42

J
jacks

audio-in 11
audio-out 11
headphone 11
microphone 11
modem 13
network 13
RJ-11 13
RJ-45 13
S-Video-out 12

K
keyboard

product description 4
removal 55
spare part numbers 17,  31, 

55
keypad keys 8
keys

fn 8
function 8
keypad 8
num lock 8
Windows applications 8
Windows logo 8

L
Label Kit, spare part number 26, 

30
LAN Power Save 91
language, changing in Computer

Setup 91
left-side components 11
legacy support, USB 87,  91
lights

battery 10
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drive 10
power 10
wireless 10

M
mass storage devices, spare part

numbers 25
Media Card Reader 10
memory check 90
memory map specifications 104
memory module

product description 2
removal 48,  59
spare part numbers 18,  30, 

48,  59
memory module compartment 14
memory module compartment

cover
illustrated 23
removal 48

microphone
release 75
removal 78
spare part number 18,  30, 

78
microphone jack

location 11
pin assignments 134

modem jack
location 13
pin assignments 136

modem module
product description 3
removal 60
spare part number 18,  31, 

60
modem module cable

illustrated 24
removal 84

monitor port
location 12
pin assignments 135

MultiBay II
location 13
product description 2

MultiBay II 24X DVD/CD-RW
Combo Drive, spare part
number 26,  27

MultiBay II 8X DVD-ROM Drive,
spare part number 26,  27
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26,  27,  30,  54
specifications 97,  98,  99

MultiBay II eject assembly
removal 85
spare part number 19,  31, 
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N
navigating in Computer Setup 88
network jack

location 13
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num lock key 8

O
operating system, product

description 5
optical drive

precautions 34
product description 2
removal 54
spare part numbers 19,  25, 

26,  27,  30,  54
specifications 97,  98,  99

P
packing guidelines 36
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parallel port mode 91
password clearing 38
passwords 90
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PC Card slot 11
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pin assignments
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headphone jack 134
microphone jack 134
modem jack 136
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Universal Serial Bus (USB)

port 137
plastic parts 33
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contents 23
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TouchPad 9
TouchPad buttons 9
TouchPad scroll zone 9

pointing devices, product
description 4

pointing stick cable
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removal 57

ports
1394 11
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monitor 12
product description 3
USB 11,  13

power button 6
power button board

removal 63
spare part number 17,  31, 

63
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power cord

set requirements 138
spare part numbers 26,  27

power light 10
power requirements, product

description 4
power-on password 90
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processor

product description 1
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product description

audio 3
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docking support 4
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R
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recovery discs
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using 127,  132

recovery partition 128,  133
recovery points 126,  131
removal/replacement

preliminaries 33
procedures 39

restoring Computer Setup factory
settings 88
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location 13
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RJ-45 jack
location 13
pin assignments 136

RTC battery
removal 58
spare part number 18,  30, 
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number 19,  32

S
S-Video-out jack
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pin assignments 137

scheduling backups 126,  131

Screw Kit
contents 105
spare part number 26,  31

screw listing 105
security cable slot 12
Security menu 90
security, product description 4
selecting in the Computer

Setup 88
serial number 15,  39
service considerations 33
serviceability, product

description 5
SIM, removal 41
smart card reader 13
smart card reader board

removal 77
spare part number 18,  32, 

77
smart card security 90
speaker assembly

removal 79
spare part number 19,  31, 

79
speakers 10
specifications

battery 96
computer 93
display 94
DVD-ROM Drive 99
DVD/CD-RW Combo Drive 98
DVD±RW and CD-RW Combo

Drive 97
hard drive 95
I/O addresses 102
interrupts 101
memory map 104
MultiBay II device 97,  98,  99
optical drive 97,  98,  99
system DMA 100

startup check 90
static-shielding materials 37
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switch cover

removal 62
spare part number 17,  30, 

62
system backup 125,  130

system board
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spare part numbers 18,  30, 
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System Configuration menu 91
system DMA 100
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system information 89
system memory map 104
system recovery points 126,  131
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Thermal Material Kit, spare part

numbers 65
thermal material, replacement 66
tools required 33
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top cover

removal 74
spare part number 18,  30, 

74
TouchPad cable, illustrated 24
transporting guidelines 36

U
Universal Serial Bus (USB) port

location 11,  13
pin assignments 137

unknown password 38
USB legacy support 87,  91

V
vents 11,  14
volume mute button 7
volume scroll zone 7

W
Windows applications key 8
Windows logo key 8
wireless antennae,

disconnecting 53,  61
wireless button 7
wireless light 10
wireless, product description 3
WLAN module
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spare part numbers 19,  28, 
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WLAN module comparment 14
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